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Introduction to Wishlist Smart Shortcodes 
 
Thank you for purchasing Wishlist Smart Shortcodes. 

Wishlist Smart Shortcodes allows you to display different types of information, including statistic information, to your members using smart 
shortcodes. 

These shortcodes can help you increase your members’ satisfaction, engagement and retention rates, and increase your revenues 
significantly. 

These shortcodes are unique and are not included in the Wishlist Member plugin itself. 

Wishlist Smart Shortcodes includes the core plugin + 3 add-ons which are available for purchase separately:  

Content shortcodes,  

Members shortcodes  

Protection shortcodes 

The core plugin is a must have, so if you purchased an add-on, please make sure you purchased Wishlist Smart Shortcodes Core plugin 

 
Statistics & Information You Can Display Using Wishlist Smart Shortcodes: 
 

• Display Available Content According to Membership Level/s (Core Plugin + Content Add-On) 
• Display / Hide Information to / from Specific Membership Levels Only (Core Plugin + Content Add-On) 
• Display Available Information for Each Member Specifically (Core Plugin + Members Add-On) 
• Display “Social Proofs” to Potential Clients (Core Plugin + Members Add-On) 
• Display Statistic Information about How Big Your Membership Site is (Core Plugin + Protection Add-On) 
• Grant Members Access to Specific Content in Just 1 Click (Core Plugin + Protection Add-On) 
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Complete Activation Process Summary in 4 Steps 
 
Follow the steps below to have Wishlist Smart Shortcodes activated and fully function on your membership site.  

Detailed information about each step including screenshots will be given further down this manual: 

Step #1: Plugin Download 
 
Download Wishlist Smart Shortcodes plugin zip file from the Purchase Receipt you received to your email. 

Step #2: Plugin Installation & Activation 
 
Install the plugin just like any other WordPress plugin from the Plugins menu > Add New. 

Step #3: License Activation 
 
Activate the plugin's license using the license key you received to your email. If you also purchased any of the add-ons, you need to copy each 
of their license keys and paste them in the Add-Ons tab. 

Step #4: Using the Shortcodes 
 
In order to use the shortcodes, all you need to do is download and activate the plugin (plus enter the license issued for you). 

There is no need to define any settings in the plugin itself other than adding the relevant parameters you want in the relevant shortcode as 
explained thoroughly in this guide. 
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Step #1: Plugin Download 
 
Download Wishlist Smart Shortcodes plugin zip file from the Purchase Receipt you received to your email as seen in the screenshot below:  
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Step #2: Plugin Installation & Activation 
 
Wishlist Smart Shortcodes can be installed easily, just like any other WordPress plugin.  

You can install it 2 ways: 

1. Upload the folder found inside the zip file to your plugins’ folder in your WordPress installation 

2. Go to the plugins menu, click the "Add New" and choose the zip file you have downloaded 
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Step #3: License Activation 
 
After you have installed and activated Wishlist Smart Shortcodes, you will find the plugin's activation setting inside the WordPress menu 
under: WL Extensions > Wishlist Smart Shortcodes: 

 

 
To activate the plugins you purchased, you need to insert the license number. 

After you activate the plugin, you will find it inside WordPress menu under: WL Extensions > Wishlist Smart Shortcodes. 
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Finding Your License Key 
 
You have 3 options to getting your licenses keys: 

1. Go to My Account > Purchases and click on the key icon: 
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2. When you finish the purchase process: 

 

  

http://happyplugins.com/?utm_source=wlss-manual&utm_medium=wlss-manual&utm_campaign=WishlistSmartShortcodes


 

3. In the purchase receipt that was sent to your email: 
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Activating the Add-Ons License 
 
If you also purchased any of the add-ons, you need to copy each of their license keys and paste them in the Add-Ons tab as seen in the 
screenshot below: 

 

You do not need to install any other plugin in the website besides the Core plugin in order to use the add-ons, only activate the add-ons 
licenses that can be found in the purchase receipt sent to your email.  
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Step #4 – Using the Shortcodes 
 
In order to use the shortcodes, all you need to do is download and activate the plugin (plus enter the license issued for you). 

There is no need to define any settings in the plugin itself other than adding the relevant parameters you want in the relevant shortcode as 
explained thoroughly in this guide. 

The Shortcodes 
There are 3 different types of shortcodes: Content shortcodes, Members shortcodes and Protection shortcodes 

Some of the shortcodes are available in the Core plugin and some are available for purchase separately as Add-Ons 

In the next page you will find a thorough overview of all the plugins. Here are the number of shortcodes you get divided to Core and Add-
Ons: 

 
Type of Shortcode 
 

No. of shortcodes 
available in the  
Core plugin 

No. of shortcodes 
available in the  
Add-On 

 
Content 

 
6 

 
5 

 
Members 

 
4 

 
3 

 
Protection 

 
6 

 
8 
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Definitions 
Here are 3 definitions that will help you better understand the content shortcodes: 

"Any level" - The member and the levels defined in the "levels" parameter have at least one level in common. 

"All levels" - The member is associated with all the levels defined in the "levels" parameter, even if he is associated with other levels as well. 

"Exact levels" – The member and the levels defined in the "levels" parameter have the exact same levels, no less, no more. 
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Wishlist Smart Shortcodes – Core Plugin Shortcodes 
 

These are the available shortcodes in the Core Plugin: 

To get detailed information plus examples for each shortcode click on the shortcode itself: 

Content Shortcodes: 
 

[wlss_display_to_members_in_any_level]  
Display the content to members who are associated with any level specified in the "levels" parameter 

[wlss_display_to_members_in_all_levels] 
Display the content to members who are associated with all the levels specified in the "levels" parameter 

[wlss_display_to_members_in_exact_levels] 
Display the content to members who are associated with the exact levels specified in the "levels" parameter 

 
[wlss_hide_from_members_in_any_level] 
Hide the content from members who are associated with any level specified in the "levels" parameter 

[wlss_hide_from_members_in_all_levels] 
Hide the content from members who are associated with all the levels specified in the "levels" parameter 

[wlss_hide_from_members_in_exact_levels] 
Hide the content from members who are associated with the exact levels specified in the "levels" parameter 
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Members Shortcodes: 

 
[wlss_total_members_in_all_levels]  
Total number of unique members in all membership levels 

[wlss_total_active_members_in_all_levels] 
Total number of active members in all membership levels 

[wlss_total_cancelled_members_in_all_levels] 
Total number of cancelled members in all membership levels 

[wlss_members_count] 
The total number of members in a specific membership level 
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Protection Shortcodes: 
 

[wlss_protected_posts_count] 
Total number of unique protected posts in a specific level as defined in the "levels" parameter 

[wlss_protected_pages_count] 
Total number of unique protected pages in a specific level as defined in the "levels" parameter 

[wlss_protected_categories_count] 
Total number of unique protected categories in a specific level as defined in the "levels" parameter  
 
 
[wlss_protected_posts_count_in_all_levels] 
Total number of unique protected posts in all levels 

[wlss_protected_pages_count_in_all_levels] 
Total number of unique protected pages in all levels 

[wlss_protected_categories_count_in_all_levels] 
Total number of unique protected categories in all levels 
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Wishlist Smart Shortcodes – Content Add-on Shortcodes 
 

These are the available shortcodes in the Content Add-On. 

To get detailed information plus examples for each shortcode click on the shortcode itself: 

 
[wlss_hide_from_members_not_associated_with_any_level] 
Hide the content from members who are not associated with any level specified in the "levels" parameter 

[wlss_display_to_members_not_associated_with_any_level] 
Display the content to members who are not associated with any level specified in the "levels" parameter 

 

 

[wlss_display_levels_posts] 
Display a list of posts accessible in each membership level 

[wlss_display_levels_pages] 
Display a list of pages accessible in each membership level 

[wlss_display_levels_categories] 
Display a list of categories accessible in each membership level 
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Wishlist Smart Shortcodes – Members Add-on Shortcodes 
 

These are the available shortcodes in the Members Add-On. 

To get detailed information plus examples for each shortcode click on the shortcode itself: 

 

[wlss_member_posts] 
All posts accessible to a specific member 

[wlss_member_pages] 
All pages accessible to a specific member 

[wlss_member_categories] 
All pages accessible to a specific member 
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Wishlist Smart Shortcodes – Protection Add-on Shortcodes 
 
These are the available shortcodes in the Protection Add-On. 

To get detailed information plus examples for each shortcode click on the shortcode itself: 

 
[wlss_payperpost_count] 
Total number of paid posts under pay-per-post protection 

[wlss_payperpage_count] 
Total number of paid pages under pay-per-post protection 

 

[wlss_protected_posts_and_pages_count] 
Total number of unique protected posts and pages in a specific level as defined in the "levels" parameter 

[wlss_protected_posts_and_pages_in_all_levels]  
Total number of unique protected posts and pages in all levels 

 

[wlss_add_to_levels_button] 
Upgrade to the level/ levels defined in the "levels" parameter in a click of a button  

[wlss_add_to_levels_redirection] 
Upgrade to the level/ levels defined in the "levels" parameter by accessing a specific content the shortcode was copied to 

[wlss_add_to_posts_button]  
Grant access in a click of a button to post/ posts defined in the "posts" parameter 

[wlss_add_to_posts_redirection] 
Grant access to post/ posts defined in the "posts" parameter by accessing a specific content  
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[wlss_display_to_members_in_any_level]  
 

Description 

Display the content inside the shortcode to members who are associated with any level specified in the "levels" parameter. 

So any member who is associated with even one of the levels specified in the "levels" parameter will see the content in the shortcode. 

Usage  
 
[wlss_display_to_members_in_any_level levels="Level 1,,Level 2,,Level 3"]  

Your content here 

[/wlss_display_to_members_in_any_level] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with a delimiter ,,  

admin_bypass 
 

Optional Always display content to admin user. Default is no. options: yes/no 

delimiter 
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 

 

  

Content Shortcode 
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Examples 

Example #1 

John, one of the members, is registered to the Silver, Pro & Advanced levels 

When using this shortcode and parameters as seen below the content will be displayed to John: 

[wlss_display_to_members_in_any_level levels="Silver,,Gold,,Premium"]  

Your content here   

[/wlss_display_to_members_in_any_level] 

 

Example #2 

John, one of the members, is registered to the Pro, & Advanced levels 

When using this shortcodes below the content will not be displayed to John: 
 

[wlss_display_to_members_in_any_level levels="Silver,, Gold,, Premium"]  

Your content here   

[/wlss_hide_from_members_not_associated_to_any_level] 
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[wlss_display_to_members_in_all_levels] 
 
Description 

Display the content to members who are associated with all levels specified in the "levels" parameter. 

So any member who is associated with all the levels specified in the "levels" parameter will see the content in the shortcode, even if he is 
associated with other levels as well.  

All levels in the "levels" parameter are associated with the member > Content is displayed 

Usage  
 
[wlss_display_to_members_in_all_levels levels="Level 1,,Level 2,,Level 3"]  

Your content here 

[/wlss_display_to_members_in_all_levels] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with a delimiter ,,  

admin_bypass 
 

Optional Always display content to admin user. Default is no. options: yes/no 

delimiter 
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 

 

Content Shortcode 

http://happyplugins.com/?utm_source=wlss-manual&utm_medium=wlss-manual&utm_campaign=WishlistSmartShortcodes


 

Examples 

Example #1 

John, one of the members, is registered to the Silver, Gold & Platinum levels 

When using this shortcode and parameters as seen below the content will be displayed to John: 

[wlss_display_to_members_in_all_levels levels="Silver,,Gold"]  

Your content here   

[/wlss_display_to_members_in_all_levels] 

 

Example #2 

John, one of the members, is registered to the Gold, & Platinum levels 

When using this shortcodes below the content will not be displayed to John: 
 

[wlss_display_to_members_in_all_levels levels="Silver,, Gold"]  

Your content here   

[/wlss_display_to_members_in_all_levels] 
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[wlss_display_to_members_in_exact_levels] 
 
Description 

Display the content to members who are associated with the exact levels specified in the "levels" parameter. 

So only members who are associated with the exact same levels specified in the "levels" parameter will see the content in the shortcode. 
Member and "levels" parameter have the exact same levels > Content is displayed 

Usage  
 
[wlss_display_to_members_in_exact_levels levels="Level 1,,Level 2,,Level 3"]  

Your content here 

[/wlss_display_to_members_in_exact_levels] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with a delimiter ,,  

admin_bypass 
 

Optional Always display content to admin user. Default is no. options: yes/no 

delimiter 
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 

 

  

Content Shortcode 
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Examples 

Example #1 

John, one of the members, is registered to the Silver, Gold & Platinum levels 

When using this shortcode and parameters as seen below the content will be displayed to John: 

[wlss_display_to_members_in_exact_levels levels="Silver,,Gold,,Platinum"]  

Your content here   

[/wlss_display_to_members_in_exact_levels] 

 

Example #2 

John, one of the members, is registered to the Silver & Gold levels 

When using this shortcodes below the content will not be displayed to John: 
 

[wlss_display_to_members_in_exact_levels levels="Silver,,Gold,,Platinum"]  

Your content here   

[/wlss_display_to_members_in_exact_levels] 
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[wlss_hide_from_members_in_any_level] 
 
Description 

Hide the content from members who are associated with any level specified in the "levels" parameter. 

So if a member is associated with even one of the levels that are defined in the "levels" parameter, the content in the shortcode will be hidden 
from him. 

Usage  
 
[wlss_hide_from_members_in_any_level levels="Level 1,,Level 2,,Level 3"]  

Your content here 

[/wlss_hide_from_members_in_any_level] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with a delimiter ,,  

delimiter 
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 

 

  

Content Shortcode 
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Examples 

Example #1 

John, one of the members, is registered to the Silver, Pro & Advanced levels 

When using this shortcode and parameters as seen below the content will be hidden from John: 

[wlss_hide_from_members_in_any_level levels="Silver,,Gold,,Premium,,Pro"]  

Your content here   

[/wlss_hide_from_members_in_any_level] 

 

Example #2 

John, one of the members, is registered to the Pro & Advanced levels 

When using this shortcodes below the content will not be hidden from John: 
 

[wlss_hide_from_members_in_any_level levels="Silver,,Gold,,Platinum"]  

Your content here   

[/wlss_hide_from_members_in_any_level] 
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[wlss_hide_from_members_in_all_levels] 
 
Description 

Hide the content from members who are associated with all the levels specified in the "levels" parameter. 

So even if a member is associated with other levels as well, as long as he has access to all the levels specified in the "levels" parameter, the 
content will be hidden from him. 

Usage  
 
[wlss_hide_from_members_in_all_levels levels="Level 1,,Level 2,,Level 3"]  

Your content here 

[/wlss_hide_from_members_in_all_levels] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with a delimiter ,,  

delimiter 
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 

 

  

Content Shortcode 
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Examples 

Example #1 

John, one of the members, is registered to the Silver, Gold & Platinum levels 

When using this shortcode and parameters as seen below the content will be hidden from John: 

[wlss_hide_from_members_in_all_levels levels="Silver,,Gold"]  

Your content here   

[/wlss_hide_from_members_in_all_levels] 

 

Example #2 

John, one of the members, is registered to the Gold & Platinum levels 

When using this shortcodes below the content will not be hidden from John: 
 

[wlss_hide_from_members_in_all_levels levels="Silver,,Gold"]  

Your content here   

[/wlss_hide_from_members_in_all_levels] 
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[wlss_hide_from_members_in_exact_levels] 
 
Description 

Hide the content from members who are associated with the exact levels specified in the "levels" parameter 

In this case, the member must be associated with the exact same levels as specified in the "levels" parameters in order for the content to be 
hidden from him. 

Usage  
 
[wlss_hide_from_members_in_exact_levels levels="Level 1,,Level 2,,Level 3"]  

Your content here 

[/wlss_hide_from_members_in_exact_levels] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with a delimiter ,,  

delimiter 
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 

 

  

Content Shortcode 
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Examples 

Example #1 

John, one of the members, is registered to the Silver, Gold & Platinum levels 

When using this shortcode and parameters as seen below the content will be hidden from John: 

[wlss_hide_from_members_in_exact_levels levels="Silver,,Gold,,Platinum"]  

Your content here   

[/wlss_hide_from_members_in_exact_levels] 

 

Example #2 

John, one of the members, is registered to the Silver & Gold levels 

When using this shortcodes below the content will not be hidden from John: 
 

[wlss_hide_from_members_in_exact_levels levels="Silver,,Gold,,Platinum"]  

Your content here   

[/wlss_hide_from_members_in_exact_levels] 
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[wlss_hide_from_members_not_associated_with_any_level] 
 
Description 

Hide the content from members who are not associated with any level specified in the "levels" parameter. 

So any member who is associated with even of the levels specified in the "levels" parameter will be displayed with the content in the 
shortcode. 

Usage  
 
[wlss_hide_from_members_not_associated_with_any_level levels="Level 1,, Level 2,, Level 3"]  

Your content here   

[/wlss_hide_from_members_not_associated_with_any_level] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with the delimiter ,,  

delimiter 
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 

 

  

Available Only in the  
Content Shortcodes AddOn 

Content Shortcode 
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Examples 

Example #1 

John, one of the members, is registered to the Pro & Advanced levels 

When using this shortcode and parameters as seen below the content will be hidden from John (no matching levels at all): 

[wlss_hide_from_members_not_associated_with_any_level levels="Silver,,Gold,,Platinum"]  

Your content here   

[/wlss_hide_from_members_not_associated_with_any_level] 

 

Example #2 

John, one of the members, is registered to the Silver, Pro, & Advanced levels 

When using this shortcodes below the content will not be hidden from John (some matching levels): 
 

[wlss_hide_from_members_not_associated_with_any_level levels=" Silver,,Gold,,Premium"]  

Your content here   

[/wlss_hide_from_members_not_associated_with_any_level] 
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[wlss_display_to_members_not_associated_with_any_level] 
 

Description 

Display the content to members who are not associated with any level specified in the "levels" parameter. 

So any member who is associated with even of the levels specified in the "levels" parameter will be hidden from the content in the shortcode. 

Usage  
 
[wlss_display_to_members_not_associated_with_any_level levels="Level 1,,Level 2,,Level 3"]  

Your content here   

[/wlss_display_to_members_not_associated_with_any_level] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with the delimiter ,,  

admin_bypass 
 

Optional Always display content to admin user. Default is no. options: yes/no 

delimiter 
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 

 

  

Available Only in the  
Content Shortcodes AddOn 

Content Shortcode 
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Examples 

Example #1 

John, one of the members, is registered to the Pro & Advanced levels 

When using this shortcode and parameters as seen below the content will be displayed (member not associated with any level >displayed) 
 

[wlss_display_to_members_not_associated_with_any_level levels="Silver,,Gold"]  

Your content here   

[/wlss_hide_from_members_not_associated_with_any_level] 

 

Example #2 

John, one of the members, is registered to the Silver, Pro & Advanced levels 

When using this shortcodes below the content will not be displayed to John (member associated with any level > not displayed): 
 

[wlss_display_to_members_not_associated_with_any_level levels="Silver,,Gold,,Platinum"]  

Your content here   

[/wlss_display_to_members_not_associated_with_any_level] 
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[wlss_display_levels_posts] 
 
Description 

Display a list of all the posts accessible in each membership level by adding the shortcode below to any post/ page you like. 

Usage  
 
[wlss_display_levels_posts levels="Level 1,,Level 2,,Level 3"]  

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with the delimiter ,,  

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 

excerpt 
 

Optional Display the posts/ pages/ categories excerpt/ description. Default is no. (options: 
yes/no) 

title 
 

Optional Display the posts/ pages/ categories title. Default is no. (options: yes/no) 

order 
 

Optional Can be ascending/ descending. Default is asc (options: asc/desc) 

order_by  
 

Optional Can be by title or date. Default is title (options: title/date) 

display_date 
 

Optional Display the posts dates. Default is no (options: yes/no) 

 

Available Only in the  
Content Shortcodes AddOn 
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Example 

[wlss_display_levels_posts levels="Level 1,Level 2" delimiter="," order_by="date"] 
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[wlss_display_levels_pages] 
 

Description 

Display a list of all the pages accessible in each membership level by adding the shortcode below to any post/ page you like. 

Usage  
 
[wlss_display_levels_pages levels="Level 1,,Level 2,,Level 3"]  

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with the delimiter ,,  

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 

excerpt 
 

Optional Display the posts/ pages/ categories excerpt/ description. Default is no. (options: 
yes/no) 

title 
 

Optional Display the posts/ pages/ categories title. Default is no. (options: yes/no) 

order 
 

Optional Can be ascending/ descending. Default is asc (options: asc/desc) 

order_by  
 

Optional Can be by title or date. Default is title (options: title/date) 

display_date 
 

Optional Display the pages’ dates. Default is no (options: yes/no) 

 

Available Only in the  
Content Shortcodes AddOn 
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Example 

[wlss_display_levels_pages levels="Level 1,,Level 2" order ="desc"] 
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[wlss_display_levels_categories] 
 

Description 

Display a list of all the categories accessible in each membership level by adding the shortcode below to any post/ page you like. 

Usage  
 
[wlss_display_levels_categories levels="Level 1,,Level 2,,Level 3"]  

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with the delimiter ,,  

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 

excerpt 
 

Optional Display the posts/ pages/ categories excerpt/ description. Default is no. (options: 
yes/no) 

title 
 

Optional Display the posts/ pages/ categories title. Default is no. (options: yes/no) 

order 
 

Optional Can be ascending/ descending. Default is asc (options: asc/desc) 

order_by  
 

Optional Can be by title or date. Default is title (options: title/date) 

 
Example 

[wlss_display_levels_categories levels="Level 1,,Level 2,,Level 3"] 

Available Only in the  
Content Shortcodes AddOn 
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[wlss_total_members_in_all_levels]  
 
Description 

The shortcode displays the total number of unique members in all membership levels.  

Usage  

All you need to do is copy and paste it in any post or page you like. 

 
[wlss_total_members_in_all_levels] 

 

 
[wlss_total_active_members_in_all_levels] 
 
Description 

The total number of active members in all membership levels 

Usage 

All you need to do is copy and paste it in any post or page you like. 

[wlss_total_active_members_in_all_levels]  

 

Members Shortcode 
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[wlss_total_cancelled_members_in_all_levels] 
 
Description 

The total number of cancelled members in all membership levels  

Usage  

All you need to do is copy and paste it in any post or page you like. 

[wlss_total_active_members_in_all_levels]  
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[wlss_members_count] 
 
Description 

The total number of members in a specific membership level defined in the "level" parameter. Can only display only one level. 

Usage  
 
[wlss_members_count level="Level 1"] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with the delimiter ,,  

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 

type 
 

Optional Options: all/ active/ cancelled members. Default is all.  
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[wlss_member_posts] 
 
Description 

All posts accessible to a specific member 

Usage  

Just add the shortcode to any post or page in order for any member to see all the posts he has access to. This is a great shortcode that can be 
used in the member’s dashboard - [wlss_member_posts] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

order 
 

Optional Order by title. Can be ascending/ descending. Default is asc. (Options: asc/desc) 

protected_only 
 

Optional Display only protected posts. Default is no. (options: yes/no) 

payperpost Optional Include pay per posts to be displayed in the lists of posts. Default is no. (options: 
yes/no) 
 

display_excerpt Optional Display the posts’ excerpts. Default is no. (options: yes/no) 
 

no_posts Optional Text to display if no posts exist to the member. Default text is "No Posts" but can be 
changed to any other text you like. (options: any text you like) 

 

Example 

[wlss_member_posts order="desc" protected_only="yes"] 

Available Only in the  
Members Shortcodes AddOn 
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[wlss_member_pages] 
 
Description 

All pages accessible to a specific member 

Usage  

Just add the shortcode to any post or page in order for any member to see all the pages he has access to. This is a great plugin that can be 
used in the member’s dashboard - [wlss_member_pages] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

order 
 

Optional Order by title. Can be ascending/ descending. Default is asc. (Options: asc/desc) 

protected_only 
 

Optional Display only protected posts. Default is no. (options: yes/no) 

payperpost Optional Include pay per posts to be displayed in the lists of posts. Default is no. (options: 
yes/no) 
 

display_excerpt Optional Display the posts’ excerpts. Default is no. (options: yes/no) 
 

no_posts Optional Text to display if no posts exist to the member. Default text is "No Posts" but can be 
changed to any other text you like. (options: any text you like) 

 

Example 

[wlss_member_pages order="desc" protected_only="no" no_posts="No Content Available"] 

Available Only in the  
Members Shortcodes AddOn 
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[wlss_member_categories] 
 

Description 

All categories accessible to a specific member 

Usage  

Just add the shortcode to any post or page in order for any member to see all the categories he has access to. This is a great plugin that can be 
used in the member’s dashboard - [wlss_member_categories] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

order 
 

Optional Order by title. Can be ascending/ descending. Default is asc. (Options: asc/desc) 

protected_only 
 

Optional Display only protected posts. Default is no. (options: yes/no) 

payperpost Optional Include pay per posts to be displayed in the lists of posts. Default is no. (options: 
yes/no) 
 

display_excerpt Optional Display the posts’ excerpts. Default is no. (options: yes/no) 
 

no_posts Optional Text to display if no posts exist to the member. Default text is "No Posts" but can be 
changed to any other text you like. (options: any text you like) 

 

Example 

[wlss_member_categories order="asc" protected_only="no" display_excerpt="yes"] 

Available Only in the  
Members Shortcodes AddOn 
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[wlss_protected_posts_count] 
 
Description  

The total number of unique protected posts in a specific level as defined in the "levels" parameter.  

Usage 

All you need to do display the number of protected posts is to insert the shortcode below to any post or page you like: 

[wlss_protected_posts_count levels="Level 1,,Level 2,,Level 3"] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with a delimiter ,,  

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 
[delimiter="your chosen symbol"] 

 
Example 

[wlss_protected_posts_count levels="Level 1,,Level 2,,Level 3"] 
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[wlss_protected_pages_count] 
 
Description 

Total number of unique protected pages in a specific level as defined in the "levels" parameter. 

Usage 

All you need to do display the number of protected pages is to insert the shortcode below to any post or page you like: 

[wlss_protected_pages_count] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with a delimiter ,,  

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 
[delimiter="your chosen symbol"] 

 
Example 

[wlss_protected_pages_count levels="Level 1,,Level 2,,Level 3"] 
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[wlss_protected_categories_count] 
 
Description 

Total number of unique protected categories in a specific level as defined in the "levels" parameter  

Usage 

All you need to do display the number of protected categories is to insert the shortcode below to any post or page you like: 

[wlss_protected_categories_count] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with a delimiter ,,  

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 
[delimiter="your chosen symbol"] 

 
Example 

[wlss_protected_pages_count levels="Level 1,Level 2,Level 3" delimiter=","] 
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[wlss_protected_posts_count_in_all_levels] 
 
Description  

Total number of unique protected posts in all levels. 

Usage 

All you need to do display the number of protected posts is to insert the shortcode below to any post or page you like: 

[wlss_protected_posts_count_in_all_levels] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 
[delimiter="your chosen symbol"] 
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[wlss_protected_pages_count_in_all_levels] 
 
Description  

Total number of unique protected pages in all levels. 

Usage 

All you need to do display the number of protected pages is to insert the shortcode below to any post or page you like: 

[wlss_protected_pages_count_in_all_levels] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 
[delimiter="your chosen symbol"] 
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[wlss_protected_categories_count_in_all_levels] 
 
Description  

Total number of unique protected categories in all levels. 

Usage 

All you need to do display the number of protected categories is to insert the shortcode below to any post or page you like: 

[wlss_protected_categories_count_in_all_levels] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 
[delimiter="your chosen symbol"] 
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[wlss_payperpost_count] 
 
Description  

The total number of paid posts that are under pay-per-post protection 

Usage 

All you need to do display this information is to insert the shortcode below to any post or page you like: 

[wlss_payperpost_count] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

include_free 
 

Optional Include payperpost that are defined as "free". Default is no. (options: yes/no) 

 

Example 

[wlss_payperpost_count include_free="yes"] 

 

  

Available Only in the  
Protection Shortcodes AddOn 
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[wlss_payperpage_count] 
 

Description  

Total number of paid pages that are under pay-per-post protection 

Usage 

All you need to do display this information is to insert the shortcode below to any post or page you like: 

[wlss_payperpage_count] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

include_free 
 

Optional Include payperpost that are defined as "free". Default is no. (options: yes/no) 

 

Example 

[wlss_payperpage_count include_free="yes"] 

  

Available Only in the  
Protection Shortcodes AddOn 
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[wlss_protected_posts_and_pages_count] 
 

Description  

The total number of unique protected posts and pages in a specific level as defined in the "levels" parameter. 

Usage 

All you need to do display this information is to insert the shortcode below to any post or page you like: 

[wlss_protected_posts_and_pages_count levels="Level1,,Level2,,Level3"] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with a delimiter ,,  

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 
[delimiter="your chosen symbol"] 

 
Example 

[wlss_protected_posts_and_pages_count levels="Pro,,Premium"] 

 

Available Only in the  
Protection Shortcodes AddOn 
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[wlss_protected_posts_and_pages_in_all_levels] 
 

Description  

The total number of unique protected posts and pages in all levels 

Usage 

All you need to do display this information is to insert the shortcode below to any post or page you like: 

[wlss_protected_posts_and_pages_in_all_levels] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with a delimiter ,,  

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 
[delimiter="your chosen symbol"] 

 
Example 

[wlss_protected_posts_and_pages_in_all_levels levels="Level 1,,Level 2,,Level3" payperpost="yes"] 

  

Available Only in the  
Protection Shortcodes AddOn 
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[wlss_add_to_levels_button] 
 

Description  

Upgrade to the level/ levels defined in the "levels" parameter in a click of a button  

Usage 

All you need to do display this information is to insert the shortcode below to any post or page you like:  

[wlss_add_to_levels_button levels="Level1,,Level2,,Level3"] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with a delimiter ,,  

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 
[delimiter="your chosen symbol"] 

label 
 

Optional The text that appears in the button. Default is "upgrade" but can be changed to any 
other text you like 

txn  Optional Specify the transaction ID that appears in the edit user screen inside the "Transaction 
ID" field beside the specific level. 
You can change the text as you like. Default is "Upgrade Button". 
 

redirect 
 

Optional The page you want to redirect members who click on the upgrade button. Default is 
the same page. [redirect="your link here"] 

 
 

Available Only in the  
Protection Shortcodes AddOn 

 

 

Protection Shortcode 

http://happyplugins.com/?utm_source=wlss-manual&utm_medium=wlss-manual&utm_campaign=WishlistSmartShortcodes
http://happyplugins.com/downloads/wishlist-smart-shortcodes-protection-shortcodes-addon/?utm_source=wlss-manual&utm_medium=wlss-manual&utm_campaign=WishlistSmartShortcodesProtection
http://happyplugins.com/downloads/wishlist-smart-shortcodes-protection-shortcodes-addon/?utm_source=wlss-manual&utm_medium=wlss-manual&utm_campaign=WishlistSmartShortcodesProtection


 

Example 

[wlss_add_to_levels_button levels="Level 1,,Level 2" txn="Upgrade Button" 
redirect="http://yourdomain.com/welcome-to-the-premium-level"] 
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[wlss_add_to_levels_redirection] 
 

Description  

The shortcodes automatically upgrades the member to the level/ levels defined in the "levels" parameter when he enters the specific content 
where the shortcode is in.  

Usage 

All you need to do display this information is to insert the shortcode below to any post or page you like:  

[wlss_add_to_levels_redirection levels="Level1,,Level2,,Level3"] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

levels 
 

Required Levels - levels names separated with a delimiter ,,  

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 
[delimiter="your chosen symbol"] 

txn  Optional Specify the transaction ID that appears in the edit user screen inside the "Transaction 
ID" field beside the specific level. 
You can change the text as you like. Default is "Upgrade Button". 
 

redirect 
 

Optional The page you want to redirect members who click on the upgrade button. Default is 
the same page. [redirect="your link here"] 

 

 

Available Only in the  
Protection Shortcodes AddOn 
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Example 

[wlss_add_to_levels_redirection levels="Level 1,,Level 2" txn="Upgrade Shortcode"] 
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[wlss_add_to_posts_button]  
 
Description  

Grant access in a click of a button to post/ posts defined in the "posts" parameter 

Usage 

All you need to do display this information is to insert the shortcode below to any post or page you like: 

[wlss_add_to_posts_button posts="732,,193"] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

posts 
 

Required List of posts IDs (SKU number of the payperpost) separated with a delimiter ,,  

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 
[delimiter="your chosen symbol"] 

label 
 

Optional The text that appears in the button. Default is "upgrade" but can be changed to any 
other text you like 

redirect 
 

Optional The page you want to redirect members who click on the upgrade button. Default is 
the same page. [redirect="your link here"] 

 
Example 

[wlss_add_to_posts_button posts="21,,32,,109" txn="Upgrade Button" 
redirect="http://yourdomain.com/claim-your-bonus"] 

Available Only in the  
Protection Shortcodes AddOn 
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[wlss_add_to_posts_redirection] 
 
Description  

Grant access to post/ posts defined in the "posts" parameter by accessing the specific content the shortcode was in. 

Usage 

All you need to do display this information is to insert the shortcode below to any post or page you like: 

[wlss_add_to_posts_redirection posts="732,,193"] 

Parameters 

You can add the below parameters to the shortcode in order to configure it better to your own membership site’s structure: 

Parameter Name Required / Optional  Description 
 

posts 
 

Required List of posts IDs (SKU number of the payperpost) separated with a delimiter ,, 

delimiter  
 

Optional You can change the default delimiter ,, and use your own delimiter symbols 
[delimiter="your chosen symbol"] 

redirect 
 

Optional The page you want to redirect members who click on the upgrade button. Default is 
the same page. [redirect="your link here"] 

 

Example 

[wlss_add_to_posts_redirection posts="Level 1,,Level 2" txn="Upgrade Shortcode"] 

  

Available Only in the  
Protection Shortcodes AddOn 

 

 

Protection Shortcode 
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FAQs 

Can the shortcodes be used in sidebar widgets? 
In order to use the shortcodes in sidebar widgets you need to download Shortcodes Anywhere plugin, a free plugin developed by 
our developers’ team that will allow you to do just that. 

 
Can the add-ons be used separately without the core plugin? 
No, in order to activate the add-ons you need to purchase Wishlist Smart Shortcodes Core 

All you need to do is copy the license issued to you after the purchase and insert it in the right place inside the core plugin > Add-
Ons tab. 

 
Why do you sell some of the shortcodes in separate plugins? 
We decided to separate the shortcodes to several different add-ons in order to allow as many Wishlist Member users to purchase 
the shortcodes they need without paying extra for shortcodes they don’t need. 

In addition to the core plugin you can purchase these add-ons: Content Shortcodes Add-On, Members Shortcodes Add-On, and 
Protection Shortcodes Add-On. 

 
What can I do if I need shortcodes that don’t exist in the plugin/ add-ons? 
Easy! All you need to do is open a support ticket through our support helpdesk with the shortcode you need and we will get in 
touch with you within 72 hours max.  
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About HappyPlugins  
 
HappyPlugins was established in 2010 to develop plugins and extension for the WordPress platform.  

The majority of the plugins are developed as white label according to our clients’ specific requirements. 

In late 2010 we opened a new branch under HappyPlugins brand for developing Wishlist Member dedicated plugins called 
Wishlist Member Developers.  

Our team at Wishlist Member Developers develops commercial and custom plugins for the Wishlist Member platform. 

Expertise 
Our expertise includes: 

 In depth knowledge and understating in the web industry 
 UXI design and improvement 
 Experience in traffic and media buying for large companies 
 Subscription-based marketing and retention 
 Conversions and flow design optimization 
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Contact information 
  
 

 

 

 

 

   

Contact Support 
 Our support team is always available to help you with any question you may have.  
 
All of our products include 3 months of free support. Any support after that period of time will be done in the 
community forums or as paid support. 

 
Important: Before contacting our support team, please check the following sources of information, as you may find the answer 
you are looking for there: 

1. Make sure you are always using the latest version of the plugin 

2. Go over the frequently asked questions section in the plugin's documentation 

3. Go over the documentation of the plugin including the troubleshooting section 

 
  

The Store 

Find unique WordPress plugins on 
our plugins’ store. We have designed 
and developed hundreds of custom 
plugins and solutions for customers 
so far and are selling the best of 
them in our store. 

The Service 

Looking for a special solution for 
WordPress, one that will complete 
the missing puzzle piece in your 
website? Please send us your request 
and we promise to return to you no 
later than 72 hours. 

The Blog 

Interested in our development work 
or want to improve your WordPress 
development skills? Check our blog; 
there we publish unique prescriptive 
and sample codes from our own 
plugins. 
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Open a Support Ticket 

If you haven’t found your answer in any of the above sources, please open a support ticket through our support helpdesk and we 
will get back to you in the next 72 hours.  

 
 

  

http://happyplugins.com/?utm_source=wlss-manual&utm_medium=wlss-manual&utm_campaign=WishlistSmartShortcodes
http://support.happyplugins.com/


 

Got Any Suggestions? 
 
We are always looking for the next idea… 

Do you have any ideas for new plugins?  

We want to hear from you! 

Please contact us and we might develop it as our next plugin. 

Contact us here 

Thanks!  

http://happyplugins.com/?utm_source=wlss-manual&utm_medium=wlss-manual&utm_campaign=WishlistSmartShortcodes
http://support.happyplugins.com/

	Table of Contents
	Introduction to Wishlist Smart Shortcodes
	Statistics & Information You Can Display Using Wishlist Smart Shortcodes:
	Complete Activation Process Summary in 4 Steps
	Step #1: Plugin Download
	Step #2: Plugin Installation & Activation
	Step #3: License Activation
	Step #4: Using the Shortcodes
	Step #1: Plugin Download
	Step #2: Plugin Installation & Activation
	Step #3: License Activation

	Finding Your License Key
	Activating the Add-Ons License
	Step #4 – Using the Shortcodes

	The Shortcodes
	Definitions
	Wishlist Smart Shortcodes – Core Plugin Shortcodes

	Content Shortcodes:
	Members Shortcodes:
	Protection Shortcodes:
	Wishlist Smart Shortcodes – Content Add-on Shortcodes
	Wishlist Smart Shortcodes – Members Add-on Shortcodes
	Wishlist Smart Shortcodes – Protection Add-on Shortcodes

	[wlss_display_to_members_in_any_level]
	[wlss_display_to_members_in_all_levels]
	[wlss_display_to_members_in_exact_levels]
	[wlss_hide_from_members_in_any_level]
	[wlss_hide_from_members_in_all_levels]
	[wlss_hide_from_members_in_exact_levels]
	[wlss_hide_from_members_not_associated_with_any_level]
	[wlss_display_to_members_not_associated_with_any_level]
	[wlss_display_levels_posts]
	[wlss_display_levels_pages]
	[wlss_display_levels_categories]
	[wlss_total_members_in_all_levels]
	[wlss_total_active_members_in_all_levels]
	[wlss_total_cancelled_members_in_all_levels]
	[wlss_members_count]
	[wlss_member_posts]
	[wlss_member_pages]
	[wlss_member_categories]
	[wlss_protected_posts_count]
	[wlss_protected_pages_count]
	[wlss_protected_categories_count]
	[wlss_protected_posts_count_in_all_levels]
	[wlss_protected_pages_count_in_all_levels]
	[wlss_protected_categories_count_in_all_levels]
	[wlss_payperpost_count]
	[wlss_payperpage_count]
	[wlss_protected_posts_and_pages_count]
	[wlss_protected_posts_and_pages_in_all_levels]
	[wlss_add_to_levels_button]
	[wlss_add_to_levels_redirection]
	[wlss_add_to_posts_button]
	[wlss_add_to_posts_redirection]
	FAQs
	Can the shortcodes be used in sidebar widgets?
	Can the add-ons be used separately without the core plugin?
	Why do you sell some of the shortcodes in separate plugins?
	What can I do if I need shortcodes that don’t exist in the plugin/ add-ons?
	About HappyPlugins

	Expertise
	Contact information

	Contact Support
	Open a Support Ticket
	Got Any Suggestions?



